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Welcome to Password Repository

Password Repository to Manage all your Passwords

Password Repository is a Cocoa native application to keep all the passwords a user 
has to manage.
Passwords are saved on disk always inside encrypted documents.
In case your Macintosh or your files are accessed by unauthorized persons, these 
person will not be able in any way to read all the data inside your Password 
Repository documents.
These let your store your important informations, credit card data, bank account 
access and so on in a safe place.
Password Repository is a standard Mac OS X document based application. You can 
manage as many documents you like, all with different data inside and anyone 
protected by a single master password of your choice.
In case you need to use Password Repository as a ʻutilityʼ application, you can 
specify in the preference to have a specific document automatically opened at 
startup, in that way you will avoid to open it manually every time you launch 
Password Repository.
We make our best to keep it powerful and simply, as any true Mac OS X application 
has to be.
We hope you will like it as many Mac users already do.
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Getting Started with Password Repository

Startup actions

At launch Password Repository opens by default an “Untitled” empty window.
It can also display a file browser to select a file to open, nothing, or open your 
preferred document at startup, depending of the preference settings.
You can change the preference settings according with your needs.

Window Organization 

Password Repository organizes the passwords in the window using an upper table 
'master' in which you have a view of all your data and a bottom section 'details' to 
see the selected element in detail.
The table is separated by the details part by a split.
You can resize them using the split

Adding Data
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Add a row in the table data using the “Add” button inside the toolbar or from the 
menu.

Every row in the upper part of the window represents a new a record in the list of 
your data.
Adding a new row switches the 'details' of the data in the bottom part of the window 
to the 'Edit' mode.
In that way you can insert the value you need.
You can always switch to the 'View' mode, with edit disabled. Useful when you are 
just browsing your data to avoid changes as mistake.

Edit Data

You can think at the “View - Edit” button as e double status button, keep "Edit" 
enabled if you are adding or editing your data, switch to the view mode, if you are 
browsing your data, to prevent unwanted changes.

Categories
Categories are a way to keep all your passwords organized. Any record has a 
'category' name that explain the 'kind' of password you are storing

First of all you need to create some categories. Assign them a different color to each 
to better recognize them. 
Selecting a category from the popup in the toolbar will filter only the matching 
records.
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You can at any moment create and delete categories using the 'Categories' sheet. 
Categories in use (with one or more notes associated) can't be deleted.
To delete a category in use you must assign to all notes using it a different category

View Data 

You can order the row by any field clicking the header in the table, and with a click in 
the little arrow in the header you can change the sort order (ascending - 
descending).

You can also search the displayed rows to the one containing a specific string. Just 
type the string on the search field on the upper-right corner of the window and as 
you type only the matching field are displayed. To come back to a full display of the 
rows, click the cross inside the search field to set a null search string.
Regarding the password field inside the table you have the option to show its 
content in clear text or as secure text (dot bullet), use the "Show Password in Table" 
under the ʻToolsʼ menu to show all them in the table. Use this  option if you have 
only trusted people able to watch at your screen on that moment.

Save Data

Now that we have data inside the document, we can save the data on disk.
Data will be saved on disk encrypted. For your safety Password Repository doesn't 
allow you to save data in plain format.
If you saved it, you can be sure you saved it encrypted.
After that, if someone will obtain access on your computer or will obtain a copy or 
your file, he won't be able to access your data even using various software tools to 
read files from disk.
Select “Save” from the “File” menu and Password repository will ask you a 
password to protect your document using a dialog sheet.
Insert a ʻmaster passwordʼ (It must be at least 6 character long) and confirm the 
dialog.
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After that, Password Repository will allow you to save the document on disk 
displaying to you the standard Save Dialog. Choose a name and a location to save.
The data will be encrypted and then saved on disk in an encrypted form.
Note that if you continue editing and modifying the document, Password Repository 
won't ask you again for a password to save it, the same ʻmaster passwordʼ you 
inserted will be used again and again to save on disk, you just have to insert it one 
time only, the first time, Password Repository will remember it for you. 
You can now close the document (if you try to close before saving, Password 
Repository as every good application will ask you if you want to save and yes … will 
ask you for a master password to protect the document if you never provided it).

Open Data

Now (after closing it) we will try to open from disk the document you previously 
saved. Use the “Open” command from the “File” menu.
Password Repository will read the file from disk but will display you a window with 
the request of the password to open it.
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This because the data in your file were saved encrypted and for now they are just a 
bunch of bit totally useless. Even an hacker with various tools won't be able to do 
anything with them. It is necessary to decrypt them and yes, it is necessary to use 
the same ʻmaster passwordʼ, exactly the same ʻmaster passwordʼ. Try different 
password, even the same password with a letter case changed (as an example 
“Myhouse” instead of “myhouse”) and it won't work.
Type the right ʻmaster passwordʼ and Password Repository will open it almost 
instantly).

Passwords

Just a warning, if you are not just experimenting and you are already working on 
your data, when you choose the master password, write it down or be sure to 
remember it. The encryption algorithm used by Password Repository is not a toy, it 
is a serious one and very strong and secure. If you will not be able to type exactly 
the right ʻmaster passwordʼ you wont be able to access your data.
Even we, the developer of this application, will not be able to open your data. There 
is nothing to do. There are no backdoors or other things. No password, no data. 
Period.
You are warned, choose a right password and keep your password in a secure 
place (see the Password Strategies section of this user guide to learn a bit about 
that) These are general rules you will find useful in your life if you deal with 
computer and password and you have no an idea about password strategies.
This should be enough to start working with Password Repository.
See the References  part to learn more about all the functions available in 
Password Repository.
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Password strategies

Donʼt Use the Wrong Master Password

Tension software did its best to let normal Mac users use Password Repository in 
the best way,simply and secure.

We mean, when we say "normal Mac users", people which don't have to be 
information technology expert.

Unfortunately as every security tools, also password Repository requires to be used 
a minimum of knowledge.

Strategic for the use of Password Repository is to select a right ʻmaster passwordʼ to 
protect your document. If your ʻmaster passwordʼ for a document is week, all your 
passwords inside the document  can be compromised.

A password, to be safe, must be unrelated to things other knows about you (the 
owner of the password), any hacker will try to guess your password using things and 
persons related to you.

Don't use name of your relatives or name of places or things or persons or ideas 
everyone knows are strongly related to you, a skilled person will try this words as 
soon as it will get his hands on your file or computer.

Don't underestimate his capacity to collect information regarding you, specially if he 
was able to put his hands on your computer.

The best part of this is that usually the persons who chose these passwords, when 
someone was able to find them and break in, says: “How he did it?”

Another well know technique to try find passwords consist of trying all the name in 
the dictionary, using automatic software tool.

The direct consequence, everyone with a minimum of skill knows, is to use for a 
password, words NOT in the dictionary, or add odd character as an example 
“suit#case” instead of “suitcase”
In password repository you can use also pass phrase as master password, so you 
can use: “my 5 red suitcase” or better “my 5 red suit#case”, instead of “suitcase”, 
which maybe is also easy to remember.
Don't use master password you used in one environment to protect another 
environment, the administrator of the first environment can know the password, why 
let him access the other environment?
The rule should be: a different password for every place.
Don't use the “Show" option to show the master passwords in clear text when you 
type the password to protect the document unless you are secure that no one or 
only really trusted people are looking at your screen.
Don't use always the "Show" option to show in clear text the passwords inside a 
document.
 
Use it if only trusted people, or no one at all, are looking at your screen.
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Be Paranoic (just a bit)

And to be a little paranoic remember that trusted people today can be your enemy 
tomorrow (strong security requires a paranoic attitude)
To remember passwords use technique used by people who impress the others 
remembering long list of data, use emotional images to remember a complete 
phrase. You know yourself, you know how to impress your mind.
In any case don't trust your memory only, SAVE your master passwords and donʼt 
save it on your Mac near your password repository document.
You can see that we avoided to say to use secure master password such as 
"slertd7js 09usdnvwof53 ndfretlu " yes, this is perfect but… who can remember it?

We know you need a master password you can remember and we know that you 
can, specially if you don't use the ʻmaster passwordʼ for a bit, forget it, even if it is a 
plain, easy to remember password.
Now, if Password Repository helps you in the work of remembering all your 
passwords, it can't help you to remember the ʻmaster passwordʼ to open your own 
document.

If you loose the ʻmaster passwordʼ to open the document containing all your 
passwords ... it can be a little trouble.
We can't help you in this circumstance. Really.
 
The suggestion is to save the ʻmaster passwordʼ on paper and to store it away from 
your computer.
If you change the ʻmaster passwordʼ remember to update the one written on the 
paper!

Now You Know

This few informations should let you be able to choose a good ʻmaster passwordʼ 
and manage it properly.

Password Repository User Guide  © 2005-2010 Tension Software! page 9



Reference

Window Organization

When launched, Password Repository opens a new window or display an open 
dialog or open your preferred document as you choose in the preference panel. You 
can set the preferences according with your needs.

Opening a new document, you can see that a document window has two main 
parts:
The upper part has a table, with every row consisting of a separate record with 
different fields, also called the 'master' part.
These fields contain specific entries such as name to distinguish the record, url, 
account name or login used, password, and a field for various note. You can 
navigate and select the table using both the mouse or the cursor.
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The bottom part of the window has fields to view and edit in details every field of the 
record selected in the upper part. If enabled you can navigate the fields also using 
the keyboard. This part is often referred as the 'Details' part.
You can resize the table and the bottom part using the split zone under the table

When you have more than one window opened, it can be useful to manage them 
with the Window” menu,. It hold a list of all the opened windows and provide 
additional command such as “Zoom”, “Minimize” and “Bring All to Front

At the very bottom of the window, the bottom bar has useful frequently accessed 
command buttons to copy data of the current selected record in the clipboard.

Toolbar

In the upper part of the window, the toolbar allow fast selection of frequently used 
commands.

You can change the layout of the toolbar in the way you do it in any other Cocoa 
application, just right-click in the toolbar, or ctrl-click (with single button mouse) and 
select from the popup menu "Customize Toolbar..."

Adding Data

When a document window is open, to add data you have 2 choice:

Pressing the “Add” button from the toolbar

Selecting the “Add Row” command from the “Edit” menu or using the keyboard 
equivalent command-key
After that a new row is added with “Untitled” in the name field and the other field 
empty.
Is up to you fill in with your value and assign the right category from the popup. If 
your data requires a new category create it and assign it via the popup.

You can add data also importing it from an external text file, see Import.

Editing Data
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You can use the fields in the bottom part of the window, to edit data of the selected 
row in the table.

The fields in the bottom part can be switched from the state( View/Edit) to allow 
changing and inserting data when necessary and to avoid unwanted changes of the 
value when you are just browsing the data.
To switch from View to Edit use the button in the toolbar or at the bottom of the 
details part.
When switching from Edit to View the appearance of the fields change to help you 
recognize the switch.

Browsing the data is the most used features after you have inserted your data and 
the "View" state is to avoid unintentional change of your data viewing them.
Using the popup you can at any moment assign a different category to a record.

A special note is for the password field, it is a secure text field which shows a series 
of bullets when you type the text, to avoid that someone looking at your monitor can 
see your passwords. 
You can click the “Show” button near the password field to switch to a clear text 
mode for the password field. 

At that point consider that other people can read and take note of your passwords.
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Another button allow to copy the content of the password field in the clipboard 
allowing to copy and paste in other applications without have to enable the editing of 
the field of having to show the password in clear text.

You can also edit data in the table directly. When “Edit” is enabled, a double click in 
the table on the field to edit, allows to edit the data “in place”, directly inside the 
table, without using the fields under the table in the bottom of the window.
For security reason the password field is not showed inside the table.

You can delete a row by selecting it and choosing “Delete Row ” from the “Edit” 
menu or clicking the “Delete” button in the toolbar.

At the bottom of the window, in the bottom bar, there are frequent used commands, 
replicated.

View Data

Password Repository allows to view data directly in the table and selecting a row in 
the table it will display data in details in the fields under the table.
You can change the selected row in the table, using the up and down arrow of the 
keyboard, when the table is selected.
You can also change the selected item using the tab key. 
The table offer another great feature, very useful when the data inside the table are 
large, you can sort the data simply with a click in the head of every column of the 
table.
To reverse the sort order just click the small arrow inside the selected column to 
invert it and reverse the sort order.
You can also adjust the width of the columns in the table using the mouse. 
Experiment with the mouse inside the table, it is totally interactive. 
Two great tools available inside Password Repository are the search field and the 
categories popup in the toolbar. 

In the search field just type a string and automatically as you type the table show 
only row with the inserted string in any field, if a row has not at least a field with the 
string typed in the search field, the row will not be shown.
Think at it as the command “Show only the rows that contains … ”
Using the categories popup is even more easy. Just select a category and only the 
records with the same category will be displayed.
You can combine both the search using the search field and the categories popup, 
only the records matching both two the request will be shown.
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When the table is showing only some of the rows in the document, you can perform 
on these rows all the usual action.

To switch back to the “Show All Rows” condition, just click the cross in the search 
field or make empty the content inside the search field. 
Simple and effective.
Search command and show category works as you type and click, after  typing or 
clicking a popup, you don't need to issue a search command, the table show the 
matching rows as you type in the search field

Categories & Search

Categories are a way to keep all your password organized. Any record has a 
'category' name that explain the 'kind' of password you are storing
First of all you need to create some categories.

Access the Category Editor form the 'Edit' menu or from the toolbar and add and 
rename some categories as you need.
You can assign to each category a different label and text color. This let you use the 
different categories to immediately recognize the type of password looking at your 
main window.

After that when in 'Edit' mode you can assign one of the available category to any 
record inside Password Repository. Consider that category are just used to copy the 
category name inside the record.
Categories in use (with one or more notes associated) can't be deleted.
(This differs from previous version of Password Repository where orphaned records 
where accepted) 
To delete a category in use you must assign to all notes using it a different category
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Search let you filter the record using a key you insert in the search field in the 
toolbar.

If you combine the use of both 'Categories' popup and 'Search' field you obtain a 
combined AND search. Only the records with the selected category and the key 
inserted will be shown.

You can always display all the records, selecting 'Show All' in the categories popup 
and deleting the key inside the 'Search Field'

You can put the insertion point in the search field manually or via menu, also using 
the Option-Command-F shortcut.

Open Url

If you insert in the Url field the url of a WEB site, when you click the 'Open' button 
near the field, it will be opened in your preferred browser. You can use drag&drop 
from the internet client to the 'Drag&Drop' area between the Url field and the 'Open' 
button to drop a Web Url in Password repository

If you insert in the Url field the url of a FTP site, when you click the 'Open' button 
near the field, it will be opened in your preferred ftp client AND, if you inserted also a 
user id and the right password, they will be used by the client to login in the ftp site, 
no typing required.

If you insert a file url, of a file on your hard disk,  in the Url field, clicking the 'Open' 
button will launch the file with the proper editor. You can use drag&drop from the 
finder to the 'Drag&Drop' area between the Url field and the 'Open' button

If you want to protect, encrypted, long rich text and images, you can use CryptoEdit 
for Mac OS X.
Password Repository allows to open a CryptoEdit file with a single click.
If you drag&drop a 'CryptoEdit' file from the finder to the 'Drag&Drop' area in 
Password Repository, AND insert also in the password field the password used in 
CryptoEdit to encrypt the file, clicking the 'Open' button Password Repository will 
launch CryptoEdit and will ask via AppleScript to open and decrypt automatically the 
encrypted file.
In that way you can open and decrypt secure encrypted files on your hard Disk with 
a single button click from inside Password Repository, no typing required. Try it, it is 
amazing!
The open url command is duplicated in the bottom bar.

Save Data
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To save a document select the 'Save' command from the 'File' menu:
In case a ʻmaster passwordʼ was not set for the current document, Password 
Repository will ask you to insert a password to protect the document.
We call the password protecting the document ʻmaster passwordʼ to distingue it from 
all the passwords you store in your document as data to save.
After that, you will be able to save the document using the save panel that will be 
automatically presented.

The document will be saved encrypted using the master password you inserted.
Note that every successive save operation will be performed without the need to 
insert the ʻmaster passwordʼ again, Password Repository will remember the ʻmaster 
passwordʼ you inserted and will use it for the document.

Every document is associated with one ʻmaster passwordʼ, if you have more than 
one document opened and you inserted a ʻmaster passwordʼ for one of them, this 
ʻmaster passwordʼ will not be used by other documents and you have to specify it for 
every new document you want to save.
Is up to you to choose to use the same ʻmaster passwordʼ for every document or a 
different one for each document.
Password Repository will ask it for every document just one time only. 

After that, any document will remember its ʻmaster passwordʼ.
You will need to use the ʻmaster passwordʼ again in a document, only if you want to 
change the master password (for security purpose) or if you closed it and you want 
to re-open it.
To change the master password you can use the ʻMaster Password...ʼ command 
under the file menu or the ʻMaster PWʼ button in the toolbar

Password Repository remembers also the position, the size of your window and the 
single width of every column of the table. This let you, opening a document, to work 
with the correct size and columns width from the start.

Open Data

To open a Password Repository document:

select “Open” from the “File” menu.
A standard Mac OS X dialog will let you select the file to open.
After that the document will need to be decrypted using the ʻmaster passwordʼ used 
to save it.

Without the right ʻmaster passwordʼ, the document canʼt be opened because data 
inside are cryptic and abstruse, not just because Password Repository has a lock. 
There is not the possibility to understand and present the data inside the document 
in a readable form even using others software. 
The ʻmaster passwordʼ is not stored inside the document in any way. 
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If you provide the wrong ʻmaster passwordʼ, the program understand it is wrong just 
because the decryption session signals it, not because it was compared with the 
right password.
 Password Repository doesn't know the right ʻmaster passwordʼ until you insert it. 
The document can't be read using tricks. If there is not the ʻmaster passwordʼ, there 
is no way to decrypt the data inside the document, even for us, the creator of the 
software. Remember it.

There are NO backdoors in the software, we have no interest to place them, and we 
acts honestly with our customers, so with Password Repository our customers get a 
tool that is based on the power of mathematical algorithm, because this is 
guaranties of effectiveness.

You are warned, loosing or forgetting the ʻmaster passwordʼ used to save a file with 
Password Repository is equal to lost the data inside the document and we can't help 
you in this unfortunate circumstance.
See the ʻPassword Strategiesʼ section of this help to learn a bit about a correct 
ʻmaster passwordʼ.
In that section you will find general rules you will find useful in your life if you deal 
with computer and password and you have no idea about password strategies.

Import

To import data inside a Password Repository document from other sources:
Select the “Import from Text File” command from the “File” menu.
An Open File dialog will let you select a file (it must be a text file ending in ʻ.txtʼ or 
ʻ.textʼ).
Select the file to import and confirm. 
Password Repository will scan the file and will present a successive dialog to adapt 
the operation exactly to the file you are importing
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You can browse one by one the record you are importing from, to see the content of 
the file you are importing using the Previous and Next buttons.

On the right side, using the popup menus you can decide where the data goes to, 
during importing.
When you have set up all the fields you want to import from and the target fields 
where you like to import to, press the ʻImport buttonʼ.
All the records will be imported inside the document.

The import operation can be performed only to opened document, so if you want to 
create a new document with the content of a text file, first create a new document 
then use the “Import from Text File” command.

Remember:
The file to import from, must be a text file. 
The tex file have to end with “.txt” or with “.text” or it won't be displayed by the 
“Choose a File” dialog. 

The text file must have been formatted in the proper way (which is the most 
common way to import/export record data from/to programs):

Every field must be separated by a TAB.
Every record must be separated by a RETURN or a NEWLINE.
Password Repository handle automatically formatted text document from Mac OS X, 
Mac OS Classic, Unix, Linux, DOS, Windows.
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The order used for the fields in the file you need to import it is not important because 
you can customize using the above dialog, what and where to import.
# # #

Export

To export the data inside a document select “Export to Text File” from the “File” 
menu.
Password Repository will present a standard file dialog: define the file to export to 
and Password Repository will export all the content of the document to the file in the 
standard text format (the same used for import)
Note that:
Every field will be separated by TAB 
Every row will be separated by a newline “\n”
Note that this is the native format for Unix platform (Mac OS X is Unix).
Mac OS Classic uses the “\r” to separate rows in text files.
DOS and Windows use “\r\n” to separate rows in text files.
You should be able to find utilities to convert text format in case you are using a 
software not able to understand the different format (as Password Repository does 
importing and handling the different format type) 

Master Password

Understanding how password are used is fundamental step for using Password 
Repository in the best way.

First of all understand that every saved document is associated with a ʻmaster 
passwordʼ.
The document needs the ʻmaster passwordʼ before it can be saved on disk.
The password protecting the document is called ʻmaster passwordʼ to distinguish it 
from the one inside the document representing your data.

The document can't be saved for security purpose in plain format (we assume that if 
you are using Password Repository you are going to save reserved data). So there 
is no way to save your data in a format others can read (except you save it 
exporting it as text data for transportation purpose to other applications) using the 
ʻExport to text fileʼ under the ʻFileʼ menu. 

If you never specify a ʻmaster passwordʼ for a document, at saving time ʻmaster 
passwordʼ will ask you a master password before saving, this to prevent someone to 
save data unprotected.
If you are working with a document and you didn't set a password for it yet, you can 
do it using the ʻmaster passwordʼ command from the 'File' menu or from the Toolbar.

The panel will ask you to insert the ʻmaster passwordʼ two times just to be sure you 
are inserting the password you want to.

Inserting a different ʻmaster passwordʼ of what you think, and don't see it because 
you are using the secure text field which display dot instead of letter as you type, it 
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is similar to don't know the ʻmaster passwordʼ used, with tragic consequence for the 
data in the document (you won't be able to access the document in future).
If you have a document with a ʻmaster passwordʼ already set, you can at any time 
change it using the ʻmaster passwordʼ command from the 'File' menu or from the 
toolbar.
To change it you must provide the old ʻmaster passwordʼ and insert and confirm the 
new one.

If you have written down the ʻmaster passwordʼ in a secure place (as an example on 
a paper) , if you change your master password, remember to update it, or when you 
will go to read it you will read the old one, and when you will try to open the 
document with the old ʻmaster passwordʼ you have changed ... you understand it, 
also smart people sometime do silly things.
Note that the ʻmaster passwordʼ is case sensitive, so “myhome” and “Myhome” are 
different password 

Please check that the caps lock of your keyboard is not inserted when you digit the 
password (unless you really want it) because if you think you have inserted 
“myhome” and you inserted “MYHOME” as long as you will try to open the 
document with “myhome” you will get a wrong password alert that can drive you 
crazy.
We reported this specific case because we noticed that is a common error by users. 
We also noticed at that point that people try to insert the same wrong password a 
zillion of time hoping the computer will accept it. 
...We inform you that if the ʻmaster passwordʼ  is wrong, Password Repository won't 
accept it, even if you try a zillion of time.

To help you avoid trouble, we added inside the password panel, a “Show” password 
button.

If you are not in an environment where someone untrusted can look at your monitor 
you can disable the secure text field and see in clear text the password you type.

Encryption

Encryption is a fundamental part of Password Repository.
Without encryption, Password Repository would be an insecure tool. 
It will not give you a guaranties that your precious data won't be accessible by other 
people.

Consider this, you use an online bank account, or PayPal, or have your credit card 
number with pin stored, or your EBay account on your computer and your computer 
(maybe a portable Mac) is stolen or maybe it just wonʼt work and you sent it for 
assistance to an assistance center. 

Yes, they do not have the password to enter your login but data on the hard disk are 
plain data, they just have to mount your computer's Hard Disk  on another machine 
and all the data inside it are accessible. 

Any power user (or less, it is needed just a bit of skill) can do that. 
Suddenly all your data are in the wrong hands (specially if they donʼt obtained your 
computer in an legal way, we assume it is not in good hands).
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If you have used Password Repository and you have used a good master password   
they can do nothing with your data, because they are encrypted with a strong 
algorithm (Blow Fish) and without the password your data are just a useless series 
of bit. 

I can't say it is impossible to decrypt them, but the effort necessary to break Blow 
Fish in the way Password Repository uses it, it is really too much for them.

Password Repository doesn't allow to save a document without a ʻmaster 
passwordʼ, this to force data to be encrypted and ask for a password of a minimum 
of 6 character to force you to use a password which has a minimum of security.
This is what Password Repository can do. It would be possible also to let the 
software choose the password for you but unfortunately you need a password you 
can remember, so you need to think yourself at the password to use.

Unfortunately very often this is a cause of big pain because people doing this don't 
realize they are disabling the scope of encryption, which is making not possible for 
other understanding the data saved.
This is the reason we dedicated on this help a page on that. 
Please, please, read the Password Strategies section, probably you already know 
about that, but if you don't know it, you must read it, not only to use Password 
Repository but just if you deal in your life, in any way, with passwords.

Preferences

General

Specify the action to do at startup
• New Document create a new document at startup
• File browser open the dialog to select a URL Extractor X document from disk to 

launch 
• None performs nothing at startup
• Open Selected Document allows to select a document and have it launched 

automatically at startup, this is a standard way to operate in case you use just a 
single document as the main repository of your notes or use often the same 
document.

To select a document you have 3 way: 
• Pressing the select from disk button and select it from the open dialog that will 

follow
• Dragging it from the finder or dragging it using the proxy icon (the icon in an 

opened document in the title bar)
• Editing it in the edit field by keyword (the hard way)
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At any successive relaunch URL Extractor X will execute the option selected.
The additional two buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch

Font

Let you specify font and format for the table list (master part of the window)

Advanced

Let you specify:
The auto saving interval if enabled (the document is autosaved on disk)
The autolock in background time interval, using it the document requires again the 
password to see the data.
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The autorecovery delay (always enabled) In case of crash the document can 
recuperate the unsaved data thanks to a parallel file the document maintains without 
user actions. This setting specify the delay interval to save in the parallel document.
To recuperate the data user has to do nothing. Password Repository do it all just 
relaunching the application after a crash.

Software Update

Password Repository can inform you if an update is available.
If enabled, the application will check no more then once a day.
ʻAsk at startupʼ asks you if you like to have the application check if an update is 
available when you start the application
ʻDisabledʼ avoids any check

When you check if an update is available, the application ping the Tension Software 
server and receive an answer about the latest release available, the application can 
in that way know if its obsolete or not.
In case the application will ask you if you like to download an upgrade.
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If you download the upgrade, you need to install it.
A common error is to download an upgrade and install it maintaining the old 
application somewhere on the hard disk.
Then using to open the documents sometime the old application and sometime the 
new one. This cause some problems*. To avoid it simply install your application in 
the place dedicated to it, the Application folder. When you install an update on the 
standard Application folder, the system will ask if you want to replace the old one 
with the new, answering yes will install the new one replacing the old.

*If the application says the document you are trying to open was created with a newer 
version of the application, probably you have two different release of the application on your 
Hard Disk and you are trying to open a document with the older version after having 
modified the document with the new one. When you receive a similar message open the 
about box inside the application and see if you are running the latest release. In case 
download it, install it and USE it!

Help

Password Repository provides a standard help menu ...maybe you already found it!
Under the help menu use the Visit Pomola.com to access our site a download the 
very latest release of Password Repository and other software for Mac we make.

Licensing the program
You can use the command under the Help menu to access our web site 
From there you can purchase a license to use Password Repository using one of 
the payment service we provide. It easy, fast, and secure.
Purchasing a license remove all the limitations inside Password Repository

If you are evaluating to purchase this software, consider that it is realized in Cocoa 
and in Objective-C, the basis of all the latest generation software for mac OS X, and 
you can expect a long life for any products based on Cocoa. Mac OS X and the 
Cocoa technology are estimated to have really really long life with continuous 
improvements (more then the life of Mac OS Classic of around 15 years) because 
Mac OS X and Cocoa are solid technologies (Mac OS classic was just a toy if 
confronted with Mac OS X) and new features can be added without problems as the 
time request them. 
This software is Universal Binaries and runs native on both PPC Mac and Intel Mac.

If you decide to purchase a license, thank you for your support. When you see on 
the net how much quality software there is for Mac and how much software is added 
every day it is because users support small developers buying software.
 

Support

You can also obtain support using the ʻSupport Email...ʼ command. An email will be 
prepared using your email client with the correct address to send to.
Yes, we answer to your emails.

Password Repository is a Commercial Program

You can use our software for a test period of 10 days
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After that you are required to buy a license to be legally authorized to continue to 
use our software

Licensing Password Repository

You can buy a license to use our software using the ʻBuy Licenseʼ command under 
the Help menu.
You will open in your browser our license web page on our web site 
From there you can buy a license to use Password Repository using one of the 
payment service we provide. It easy, fast, and secure and all most important form of 
payment are accepted.
We carefully selected or international reseller to be sure the buying experience for 
our customer will be as best as possible and without any problems.
After purchase you will receive from Tension Software a license email containing 
your full name and a license code
Open the License dialog with the command ʻlicenseʼ under the ʻPassword 
Repositoryʼ menu and insert these data in the License dialog. The software will 
become fully licensed and fully enabled for future use.

Name and license code are remembered by the program and donʼt need to be re-
inserted at successive launch.
In case you move on a new Mac you need to re-insert your name and license
The license is valid for a single Macintosh. You can purchase for two Mac as long as 
they are not used at the same time, as example a desktop and a laptop used by the 
same user.

Consideration about Licensing Password Repository

If you are evaluating to purchase this software, consider that it is realized using the 
Cocoa library (the native latest generation library on Mac OS X) and in the 
Objective-C language (the first class language development on Mac OS X)
The two technology are the basis of all the latest generation software for Mac OS X, 
and you can expect a long life for any products based on Cocoa and coded in 
Objective-C.

Mac OS X and the Cocoa technology are estimated to have a really long life with 
continuous improvements (more then the life of the now ancient Mac OS Classic 
which was  around 15 years) because Mac OS X and Cocoa are solid technologies 
(Mac OS classic was just a toy if confronted with Mac OS X) and new features can 
be added without problems by Apple when they are required. 
It was not so easy with previous generation of OS.
In our opinion the Cocoa technology will live and grow for many decades from now, 
so Cocoa based software are today the best way to go if you have to select software 
to use.

If you decide to purchase a license, thank you for your support.
When you see on the net how much software there is for Mac and how much 
software is added every day, it is because users support small developers buying 
software and because the Macintosh software ecosystem itʼs really a great place to 
work due to the incredible success the Macintosh has today and the common 
feeling of the community (we use the Mac because we love doing things in a smart 
way).
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